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System Requirements 
To use ALERE® Business Applications, you must have a computer that meets (or 
exceeds) the following requirements: 
 

• IBM® compatible PC operating at 1 GHz or higher (2 GHz or better 
recommended) 

• 1 GB of RAM (more is recommended) 
• 100 Mbps or higher network connection (1 Gbps recommended) 
• 250 MB available disk space on the local drive for stand-alone or server 

installation to provide space for programs and data 
• 50 MB available disk space on the workstation drive for Runtime files and 

temp files 
• CD-ROM drive 
• Microsoft® Windows® XP, Vista, Windows 7, 8, or 10 
• 1024 x 768 or higher resolution is required 
• Any Windows® compatible printer to print reports 

 
Note Running ALERE® Business Applications client/server requires Microsoft 

SQL Server 2000 or newer and a matching number of user licenses. 
See the Microsoft web site for SQL Server system requirements. 

Note ALERE® LAN should be installed on the server with disk caching and 
opportunistic file locking (SMB2/SMB3) turned off. This is not required if 
all users are connected via RDP, and the ALERE® program and data 
are on the Terminal Server computer, or if the companies are all set up 
in Client Server. 
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The installation of ALERE® Business Applications LAN or client/server version is 
performed with the same CD and follows the same steps. To install ALERE® Business 
Applications software 
 
1 Read the Software License Agreement. 
2 Have on hand the Activation Key sent with the software. If you do not have the 

Activation Key, call 610.258.5161. 
3 Close all open applications. 
4 Disk caching should be disabled and virus scanning software should exempt the 

folders where the program and data will reside. 
5 Insert the ALERE® Business Applications CD-ROM into the CD-ROM drive. The 

installation program will start automatically. 
6 Follow the on-screen instructions as they appear. 

Installation 
1 On the “Welcome” screen select the Next button to continue the install. 
2 Check the radio button marked “I accept the agreement” and then the Next 

button to continue. 
3 On the Select Components screen, select the type of installation from the pull-

down box that is showing “Single User Installation”. The options are Single user, 
Multiuser Server, Multiuser Workstation, or Custom. The appropriate options will 
be automatically checked in the box below. Select the Next button. 

 
Note Installation of ALERE® on a LAN or Client/Server network requires a 

single server PC and one or more remote PCs (workstations). You must 
install this software on the server PC first; then it can be installed on the 
remote PC(s). 

Note It is suggested that the program be installed in a generic “ALERE” 
directory. 

 
4 Select the Next button. 
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5 Accept the directory in which to install the Runtime files or specify another. 
Select the Next button. Note that on a traditional network these files must reside 
on the local workstation. 

6 Select the desired additional tasks and then select the Next button. 
7 Select the Install button to start the installer. A progress bar displays the status 

of the installation process. When the process is complete, select the Finish 
button. 

8 Remove the CD-ROM from the drive and restart the computer. You are now 
ready to start ALERE® Business Applications. 

Remote PCs (Workstations) 
Note Setup may be run from the CD or by selecting the SETUPMU.EXE 

program from the server. 
 
1 Set the choice to “Multiuser Workstation” and select the Next button. 
2 Check all the options and select the Next button. 
3 Specify the path and directory on the LAN administrator PC where the program 

files reside. Select the Next button. 
4 Accept the directory in which to install the Runtime files or specify another. 

These files need to be on your local drive. Select the Next button. 
5 Accept the desired additional tasks and select the Next button. 
6 A progress bar displays the status of the installation process. When the process 

is complete, select the Ok button. 
7 Remove the CD-ROM from the drive and restart the computer. 
8 Repeat this process for each workstation. You are ready to start the program. 
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Installing New Versions 
All software evolves and that holds true for ALERE® Business Applications. The 
following information will help you when installing updates and new releases. 

New Directory vs Overwriting Existing Directory 
TIW requires that upgrades be installed in a new program directory for three reasons: 
 

• It is easy to copy changes that have been made, the login table, and the 
company default table from the older version. Otherwise, the files would have 
to be copied beforehand to prevent them from being overwritten when 
installing ALERE® Business Applications. 

• Obsolete files may accumulate needlessly over time. A fresh directory avoids 
unnecessary files. 

• Leaving the previous version intact provides a "fallback" position and makes 
technical support easier. 

 
The program installs quickly, takes up little space and easily links to your existing 
data. 
The first time you install the program, create a generic directory which will hold all 
versions of the program files now and in the future. For example: T:\ALERE. Install the 
program in that directory. 
If this is not the first time you have installed the program, then install it to a new 
directory (T:\ALERENEW). 
Once the installation is complete, copy the wsaccess* and wslogins.* files from the 
previous version, located in the SysFiles Directory, to the new program directory.  If 
updating from Version 11 or higher also copy the wsalere.dbf. Enter ALERE® 
Business Applications and run TIW File Update for every company.  
If updating from versions prior to 11, it is necessary to create new companies from the 
old data. Version 11 requires new directories or databases to be created. It is 
suggested that you open the Company Defaults screens of versions prior to 11 to 
make it easier to create the Company Default settings of the new company. 
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Using a sample company, test the new installation. Once testing is complete, rename 
the old installation to ALERE_V(XX) and rename the new install (\ALERENEW) to 
your original directory name (\ALERE). 
The startup properties on each workstation will not need to be pointed to the new 
directory using this method. 
 

Note  It is highly recommended that the General Installation Notes, included 
with the retail packaging, be referenced prior to upgrading ALERE. 

Bringing Forward Modifications 
Information on how to bring forward changes to the language sets, modifications with 
or without the Developers Source Kit, new custom reports, and modified existing 
reports can be found in the General Installation Notes. These notes are updated 
with each release and are included on a separate document included in your 
shipment. 

Installing the HTML Manual on each Workstation 
A Microsoft Security Update prevents CHM (compiled HTML files) from being viewed 
when they are being loaded from a network drive or remote server. This can affect 
computers running Windows® XP or newer. 

1 When the installation program is set to install the manual on a workstation the 
following steps should not be necessary. However, if the HTML manual cannot be 
viewed when the Help button on a screen is selected, then follow these 
instructions. 

2 Start ALERE® and head to File > Maintenance > Company Defaults > Options. 
3 Select the “Use HTML Help” and “HTML Manual on Work Stations” options. 
4 Save the change, exit the screen, and restart ALERE. The workstation will 

automatically download the manual from the server and use it locally. Thereafter, 
the manual will automatically be updated whenever the manual on the server is 
updated and ALERE® is restarted on the workstation. 

5 Right click on your desktop shortcut to the ALERE® manual and select 
“Properties”. 
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6 Change the target to:  

“C:\TIWRUN\ALERE\ALEREMANUAL.CHM” 
(Assuming your runtime files are at C:\TIWRUN) 

7 Change the “Start In:” directory to “C:\TIWRUN\ALERE”. 
8 Start the manual from your desk top shortcut. If you get a message asking if you 

want to start the program, select “Always” or “Yes”. 
9 Verify that the contents and index show at the left side of the screen. If they do 

not, click on the “Show” button at the top left of the screen. If you do not have that 
button, use your mouse to drag the bar just inside the left edge of the screen to 
the right. 

The Manual should now work from the shortcut or from within ALERE®. 

Starting the Software for the First Time 
To start ALERE® Business Applications 
1 Select the icon on the desktop. The first screen to appear is the ALERE Version 

Key Entry screen. 
2 Enter the serial number and Activation Key and select the OK button. 
3 The Help files will be setup and ALERE, Inc., the sample company that was 

automatically installed, will be opened.  

Note To only display the Accounting or Manufacturing ribbons, navigate to 
File > Maintenance > Login Options. In the center of the screen, there is 
an option entitled Default Ribbon which may be changed to view only 
Manufacturing or Accounting. 

  



  Quick Start Guide 

9 | P a g e  
 

Adding New Companies 
The following sections discuss how to add new LAN companies to ALERE®. 

Before You Begin 
There are several key pieces of information that you should have available before 
adding a new company. They are as follows: 

 A decision on whether or not items will be allowed to be overissued from 
inventory when there are none on hand. 

 A decision on whether or not order numbers (such as sales orders, 
purchase orders, etc.) are to be manually entered or auto assigned. 

 The inventory valuation system that will be used. The choices are 
Standard, Average, LIFO, and FIFO. 

 
Note Once selected, the valuation method cannot be changed from the 

screen. 
 

 The structure of the general ledger account numbers. Up to 24 spaces 
with six segments are permitted. The first segment, called the Major 
Segment, must be numeric. The remaining five segments may be 
alphanumeric. 
 

Note Once set, segments may be added only. 
 

 A company ID which may be up to six spaces wide and alphanumeric. 
 A decision on what to name your inventory location. 
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Adding a New LAN Company 
1 Select the New button on the Open Company screen. 
2 On the screen enter the name of the new company, set the database type to LAN, 

and select/create the directory in which its data will be kept. 

 
Note ALERE® Business Applications will allow you to create the new 

directory if one does not presently exist. If it does exist, the F2 key or a 
double left click in the path field will display it. 

 
Caution TIW requires that the files for each company be kept in separate 

directories. Do not place the company files in the same directory as the 
program files or in a subdirectory of those files. Under no 
circumstances should company data be mixed with other 
programs or data. It is strongly recommended that the TIWDATA 
directory is created and a separate subdirectory is added for each 
company that is set up. 

 
3 Select the Continue button when the information has been entered. The following 

checks are made: 

 

 If the name of the new company is already used, a message in the upper 
right-hand corner of the screen will let you know. Reenter a different name. 

 If the new company's data path matches an existing company, you will be 
notified. Reenter a different path. 

 You will be notified if the new company's data path does not match an existing 
company but company data files are present. Reenter a different path, 
overwrite the existing files, or choose not to overwrite them. The last option 
will leave the files intact so that the new company can be connected to them. 
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4 The Company Defaults screen is then displayed.  
 
Caution The inventory valuation method and GL structure cannot be changed 

once saved. Ensure these are correct prior to saving. 
 

5 Complete the information required on the screen and save it. 
6 Upon exiting the screen you are returned to the Company Menu screen where 

you may now select the new company. 

SQL Installation 
The install process installs both the LAN and Client/Server ALERE®. The following 
sections discuss how to add new SQL companies to ALERE®. Microsoft SQL Server 
2000 or newer must be installed prior to these steps. 

Converting LAN Data to SQL 
Microsoft SQL Server 2000 or newer must be installed, and ODBC connections from 
the workstations need to be set up prior to creating ALERE® SQL companies. 
ALERE® Client/Server does not come with a sample company. Use this process to 
convert the ALERE® Accounting sample company, which is in VFP tables, to an 
ALERE® client/server sample company. 
 
1 Run ALERE® Business Applications and select the new (empty) client/server 

company. 
2 From the menu, select File > System Tools > Access FoxPro. 
3 Type "DO LanToCS WITH <SQLDBNAME>" where <SQLDBNAME> is the name 

of the SQL Server database that will receive the converted data. 

 
Note The data name must be within quotes. For example, DO LanToCS 

WITH "ALEREINC" 
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When the Select Directory dialog pops up, select the directory containing the LAN 
company files. The utility will convert the LAN company data into the new client/server 
company.  

Adding a New SQL Data Source 
1 From Windows Control Panel or Administrative Tools, run Data Sources (ODBC). 
2 Click the System DSN tab on the ODBC Data Source Administrator screen, and 

then click the Add button. 
3 Select the "SQL Server" driver from the list and click the Finish button. 
4 Enter "TIWSQL" in the Name field, "TIW SQL Server" in the Description field, and 

enter the SQL Server that will contain ALERE® data in the Server field. Click Next. 
5 Continue with the DSN Configuration, choosing the desired settings or keeping 

the defaults. Click the Finish button to complete the configuration. 
6 In SQL Server, assign the proper user access privileges in the new database. 

Adding New SQL Companies 
1 Select the New button on the Open Company screen. 
2 On the screen enter the name of the new company, set the database type to 

Client/Server, and enter the Server, database name, Login, and Password in 
which its data will be kept. 

 
Note ALERE® Business Applications will create the new database if it does 

not presently exist.  
 

3 If you are creating the new company from previous versions of ALERE®, select 
the appropriate “Import From” options at the bottom of the Add New Company 
screen. You can create a Client/Server company from either LAN or existing 
Client/Server data. 
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4 Select the Continue button when the information has been entered. The following 
checks are made: 
 If the Company Name is already used, a message in the upper right-hand 

corner of the screen will let you know. Reenter a different name. 
 If the new company's database matches an existing company, you will be 

notified. 
6 The Company Defaults screen is then displayed.  

 
Caution The inventory valuation method and GL structure cannot be changed 

once saved. Ensure these are correct prior to saving. 
 

7 Complete the information required on the screen and save it. 
8 When you exit the screen, you will be taken to the TIW File Update screen. Run 

the file update on the new company. 
9 Upon exiting the screen, you will be returned to the Company Menu screen where 

you may now select the new company. 

Basic Accounting Implementation Steps 
There are a series of basic implementation steps that should be performed before 
using a newly created company. They are as follows: 
 

• Set up user login permission as appropriate. 
• Establish a Chart of Accounts. 
• Set up the Default GL Accounts. 
• Establish the fiscal periods. 
• Enter beginning general ledger balances. 
• Review and setup necessary global definitions for codes, payment terms, 

units of measure, checking accounts, and tax tables. 
• Enter inventory information if inventory is being used. 
• Build customer and supplier lists. 
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Basic Manufacturing Implementation Steps 
There are a series of basic implementation steps that should be performed before 
using ALERE® Business Applications. They are as follows: 
 

• Review and establish the company defaults and links to accounting. 
• Set up user login permission as appropriate. 
• Review and set up global definitions, including email rules. 
• Establish bills of material, operation library, routes, material assignments, 

work centers, product classes, labor grades, maintenance procedures, and 
closed dates as necessary to the operation of the software. 

Technical Support 
TIW offers technical support for a period of one year after the initial purchase of the 
software. Technical support is also included in the Software Maintenance Agreements 
(SMA’s) and Technical Support Contracts. 
Call 610.258.5161 or email tech@tiwcorp.com. A Technical Support Form may also 
be used to submit questions or issues on the website at 

www.tiwcorp.com/tech_support_form.html/ 

Be sure you have the following information when you contact us: 

• The serial number and version of the software 
• The name and version of your PC operating system 

Guidelines for Reporting an Issue 
 As best as you can, know the steps to creating the problem. 
 If you have encountered an error message, carefully record it. The first error 

message encountered is the most important. 
 Let us know if the problem was preceded by any odd behavior or 

network/hardware problems. 
 Report any modifications to the hardware or software being used. 
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Scope of Technical Support 
Technical Support is designed to answer specific questions regarding how the 
software functions and what features are designed to do, report problems and 
address other technical issues. Explaining disciplines, training, installation, and 
systems hardware and network configuration are properly the responsibility of 
Authorized TIW Dealers. 

Factory Training 
TIW offers a wide scope of training and services designed to support you and your 
Dealer. The first step in deciding on which of these services might be appropriate is to 
discuss your requirements with your Dealer. 

Technical Seminar 
This course benefits both the new user and acts a refresher for the current user. After 
this three day course for Accounting or two-day course for Manufacturing, you should 
know how to: 
 

 Install the software and set up a company. 
 Step through the implementation sequence for each module. 
 Use the features and processes. 
 Apply the underlying concepts and understand why they are so important to 

the proper running of the software. 

Developer’s Seminar 
This course is designed for the advanced user or developer who would like to 
understand how to use the powerful software architecture to make customizations, 
add capabilities or create vertical applications. In this three day course you will learn 
how to 
 

 Create a good modification strategy. 
 Use the many program hooks embedded throughout the software. 
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 Modify the menus. 
 Make report modifications and add new ones. 
 Add and modify forms. 
 Make use of the many callable functions. 

Custom Consulting/Training 
This is a mission critical application. Sometimes you need available a level of training 
and consultation that goes far beyond a classroom. For those occasions, TIW makes 
available on-site factory assistance. This type of support is appropriate when 
 

 You want your key people trained on-site with your own company data. 
 You need to understand the far-reaching consequences of implementation or 

operational decisions. 
 You feel that you are only utilizing a fraction of the potential of the software 

and want to know how to move to the next level. 
 You need a second opinion or advice on the use of key technology in the 

product. 

Web Based Technical Training 
These courses are custom designed to suit your company’s specific questions when 
using ALERE. Web Based Technical training is ideal for 
 

 Companies with multiple locations where users would be required to travel for 
training. 

 Companies in search of an economical training solution which will not stop 
production. 

 Training users to enable the utilization of more advanced features. 
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